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Introduction

This manual contains detailed instructions and notes on the operation and use of this product. For your
safety and benefit, read this manual carefully before using the product. Keep this manual in a handy
place for quick reference.

Trademarks

Microsoft, Windows, Windows Server, Windows Vista, Excel, and PowerPoint are either registered
trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Adobe, Acrobat, and Reader are registered trademarks of Adobe Systems Incorporated.
Outside In Viewer Technology Copyright (C) 1992-2003 Stellent Chicago, Inc. All rights reserved.
Jaws PDF Editor SDK. Copyright (C) 2005 Global Graphics Software Ltd. All Rights Reserved.

Other product nhames used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The product names of the Windows operating systems are as follows:

e The product names of Windows 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

e The product names of Windows XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

e The product names of Windows Vista are as follows:
Microsoft® Windows Vista® Ultimate
Microsoft® Windows Vista® Enterprise
Microsoft® Windows Vista® Business
Microsoft® Windows Vista® Home Premium
Microsoft® Windows Vista® Home Basic

* The product names of Windows Server 2003 are as follows:
Microsoft® Windows Server® 2003 Standard Edition
Microsoft® Windows Server® 2003 Enterprise Edition

* The product names of Windows Server 2003 R2 are as follows:
Microsoft® Windows Server® 2003 R2 Standard Edition
Microsoft® Windows Server® 2003 R2 Enterprise Edition



DeskTopBinder Manuals

Read the descriptions in each manual according to your purpose.

& Note

To display PDF form manuals, Adobe Acrobat or Adobe Reader must be in-
stalled on the client computer.

Setup Guide

This manual explains setup methods and operating environment required to
use DeskTopBinder.

It also describes about settings necessary after DeskTopBinder installation
and how to deal with problems occurring during DeskTopBinder operation.

Introduction Guide

This manual explains basic setting methods and operating procedures for
DeskTopBinder using graphics as dialog box or window examples.

It also describes about Function Palette and other tools installed at the same
time as DeskTopBinder.

Auto Document Link Guide

This manual explains how to set delivery server in-trays, Windows folders,
Fax Received Files, and a Caplio digital camera as monitored items, and
transfer methods for documents or files found in the items.

It also describes about how to deal with problems occurring during Auto
Document Link operation.
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How to Read This Manual

Symbols

In this manual, the following symbols are used :

ﬁklmportant

This symbol indicates a situation that may result in property damage or mal-
function if instructions are not followed. Be sure to read the instructions.

5] Preparation

This symbol indicates information or preparations required prior to operating.
& Note

This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

@ Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference

This symbol indicates a reference.

[]

Elements on the machine's display panel or the computer's display, such as keys,
buttons, and menus.
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1. Overview of ScanRouter System

Overview of ScanRouter System

ScanRouter System is a group of document management applications that helps
users improve their business efficiency and productivity, and speed up manage-
ment and organizational procedures.

The volume of electronic and paper documents that must be stored increases on
a daily basis. ScanRouter System can efficiently manage huge amounts of docu-
ment data, such as scanned-in/fax-received image data and files made using
computer applications-creating a work environment that is optimized for busi-
ness usage information.

ScanRouter System documents can be easily retrieved, viewed, edited, printed,
and sent by e-mail to communicate information to any person at any time.

In addition to supporting a wide variety of user authentication methods, for ex-
tra security, ScanRouter System can protect users' documents using easily made
access settings.

ScanRouter System includes the following applications:
= DeskTopBinder Lite/Professional

= ScanRouter V2 Lite/Professional

= ScanRouter Enterprise

= ScanRouter EX Professional/Enterprise

= ScanRouter DocumentServer

= ScanRouter Web Navigator
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Data flow when a delivery server is used

B 1exssresresnaaans Data flow when DeskTopBinder and
a document management server are used

C = = = = = = Data flow when ScanRouter Web Navigator is used

1. Network devices

You can input or output documents us-
ing network devices.

Documents scanned from a scanner or re-
ceived by fax are sent to the delivery
server.

If there is a hard disk drive (Document
Server) on a network device, the Docu-
ment Server receives documents read by
network device or received by fax. Docu-
ments in the Document Server can be
used with ScanRouter System software
products.

ADP001S

2. ScanRouter V2 Lite/Professional,
ScanRouter Enterprise, and Scan-
Router EX Professional/Enterprise
(delivery server)

The server works with other devices on
the network to deliver documents. Docu-
ments received from network devices are
delivered according to the delivery meth-
od configured for each destination.

Possible delivery methods include: sav-
ing in in-tray, sending by e-mail, and
adding to a document management serv-
er folder.
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3. ScanRouter DocumentServer
(document management server)

Documents created in different kinds of
application can be added from DeskTop-
Binder and ScanRouter Web Navigator to
the document management server. The
server arranges, sorts, and manages these
documents.

Configuring access rights for each cabi-
net and folder in the server restricts us-
er/group access and operations they can
perform, and prevents unwanted docu-
ment tampering.

4. ScanRouter Web Navigator (Web
server)

ScanRouter Web Navigator is a portal ap-
plication enabling access from Web client
to document management server and de-
livery server in-trays using a Web brows-
er.

It is not necessary to install ScanRouter
Web Navigator on each client computer,
since document operations can be per-
formed using the Web browser on client
computers.

5. Web Browser (client computer)

Client computers access the Web server
through the Web browser to search, dis-
play, and download documents in an in-
tray or in the document management
server.

6. DeskTopBinder Lite/Professional
(client computer)

On a client computer, DeskTopBinder
Lite/Professional manages various kinds
of data as documents.

Using DeskTopBinder Lite, documentsin
the delivery server can be viewed and
managed. Using DeskTopBinder Profes-
sional, documents in the document man-
agement server and delivery server can
be viewed and managed.

When Document Server is used with a
network device, documents in Document
Server can be viewed from or copied to
DeskTopBinder Lite/Professional to be
edited or managed.
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DeskTopBinder

DeskTopBinder

DeskTopBinder can integrate various kinds of data, such as files made with dif-
ferent applications, scanned image data, and existing image files for total docu-
ment management.

When only DeskTopBinder is used, documents created on a computer can be
managed. However, by adding network locations from Extended Features, you
can view and manage documents in ScanRouter V2 Lite/Professional, Scan-
Router Enterprise, or ScanRouter EX Professional/Enterprise in-trays, or Scan-
Router DocumentServer cabinets using DeskTopBinder.

Furthermore, when DeskTopBinder is used with input/output devices, adding
scanned-in documents and outputting (Print and Send by Fax) documents from
DeskTopBinder are available. Depending on the network devices, saved docu-
ments in Document Servers can be copied to DeskTopBinder.

Documents in Document Servers can also be printed and outputted from Desk-
TopBinder.

Functional differences between DeskTopBinder Professional and DeskTopBinder Lite

ﬂlmportant
There are two types of DeskTopBinder: DeskTopBinder Professional and
DeskTopBinder Lite. Both are described as DeskTopBinder in this Introduc-
tion Guide. Note that DeskTopBinder Professional has all the functions of
DeskTopBinder Lite plus some additional functions.

The following functions are not possible with DeskTopBinder Lite:
= Convert to PDF (displaying/setting PDF security information)
= Convert to Text (extract text from image using OCR)

= Using Viewer and Easy Viewer to display non-image files such as PDF files
and files created using an application

= Send by E-mail

= Import HTML

= Export HTML

= Export Document Properties Summary in CSV format

= Entry Assistant

= Print Document Properties Summary by List

= Specific Search

= Content Text Search for DeskTopBinder My Cabinet documents
= Create Content Text Search data



DeskTopBinder

Connection to ScanRouter DocumentServer

Creating shared cabinets

Creating removable cabinets

Using in a MetaFrame or Terminal Services environment

? Limitation

To display application data in the Thumbnails view of DeskTopBinder Lite,
the application used to create the data must be installed on the client comput-
er.

ScanRouter V2 Lite/Professional, ScanRouter Enterprise, and
ScanRouter EX Professional/Enterprise

Incorporated with the ScanRouter delivery server, DeskTopBinder enables users
to view documents in in-trays and deliver them. The ScanRouter delivery server
must be configured using Extended Features in advance. ScanRouter has five
types: ScanRouter V2 Professional, ScanRouter V2 Lite, ScanRouter Enterprise,
ScanRouter EX Professional, and ScanRouter EX Enterprise.

ScanRouter DocumentServer

Incorporated with ScanRouter DocumentServer, DeskTopBinder enables users
to access and control documents in the server from client computers (DeskTop-
Binder). ScanRouter DocumentServer must be configured using Extended Fea-
tures in advance.

Each document can have specific document properties in addition to the file
name. These properties can be used to search for necessary documents.
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Document Management

Cabinets and Folders

Added documents are stored in a cabinet. In this cabinet, you can create folders
and use them to sort documents.

This cabinet has a trash can where deleted files and documents are placed.

Ny

1. Document 3. Cabinet

2. Folder

? Limitation

When DeskTopBinder is installed, no more than one My Cabinet can be cre-
ated. However, shared cabinets and removable cabinets can be created as
needed.

ANLO15S

Documents and Sections

You can add multiple files made with various applications as one document.
When saving multiple files as a document, one file becomes one section, and one
document is composed of multiple sections.

EEEES
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1. Section 3. Data made with applications and

2. Document scanned image data



Document Management

Document Properties

Document properties are attribute information configured for each document.

With DeskTopBinder, document properties can be configured or checked on the
[Summary] and [Contents] tabs in the properties dialog box.

For properties of document management server or delivery server documents,
[Document Type] can separate documents according to document type and man-
age them.

Summary

Document properties summary, including information such as the creator, work
status, and expiration date, make document management easier.

Using DeskTopBinder, you can configure properties summary for each docu-
ment and check them using Properties. Items that can be checked are document
name, size, location, date added/modified/created, creator, work status, and
expiration date.

The document type determines the displayed items for document properties
summary of the document management server or delivery server documents.

Contents

A document is composed of multiple sections. On the [Contents] tab, information
about sections can be checked.

You can check status of thumbnail and Content Text Search data creation for sec-
tions. If necessary, you can create them again.

Document type

For ScanRouter DocumentServer, ScanRouter V2 Lite/Professional, ScanRouter
Enterprise, and ScanRouter EX Professional/Enterprise, [Document Type] is avail-
able on the [Summary] tab in the document properties dialog box.

Each cabinet can be configured to hold documents with certain document types.
By separating documents according to document type, document management
becomes easier.

In addition to the basic document type, ScanRouter specific document types are
available with ScanRouter. Documents added from input devices by way of
ScanRouter V2 Lite/Professional, ScanRouter Enterprise, and ScanRouter EX
Professional/Enterprise can be configured as ScanRouter specific documents.
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Document type in ScanRouter DocumentServer

Using ScanRouter DocumentServer, you can configure document type. Dis-
played items on the [Summary] tab in the properties dialog box may differ de-
pending on the document type. By configuring document type, efficient
management of various kinds of documents becomes possible. Each document
can only be configured as one document type. Document types must be created
by the administrator in advance.

Document type of in-tray documents

Each document delivered in the in-tray of ScanRouter V2 Lite/Professional,
ScanRouter Enterprise, and ScanRouter EX Professional/Enterprise has a specif-
ic document type depending on the capture method.

Displayed items on the [Summary] tab in the properties dialog box may differ de-
pending on the document type.

Document Shortcuts

Shortcuts of ScanRouter DocumentServer documents

Using ScanRouter DocumentServer, you can create shortcuts to display fre-
quently used documents easily. For example, you can create a shortcut for a doc-
ument with a long path and paste it in a folder with a short path, or you can copy
a shortcut of a document with a long path and paste it in a DeskTopBinder fold-
er. By double-clicking the shortcut you can immediately display the document.
This allows easy access for frequently used documents.



Document Management

Security for Document

ScanRouter DocumentServer, ScanRouter V2 Lite/Professional, ScanRouter En-
terprise, and ScanRouter EX Professional/Enterprise have the following securi-
ty functions to restrict access to documents viewed and used by multiple users.

Security and access rights in ScanRouter DocumentServer

Each ScanRouter DocumentServer cabinet and folder has an access control list
(ACL) to limit user access and the operations users can perform.

Configuring access rights for each cabinet or folder restricts access and prevents
unwanted document tampering. Various kinds of access rights are available, in-
cluding, viewing only, editing, and deleting.

Q G'—*%.:“_ |
t

R TN
i
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1. Document 4. Viewing possible
2. Trash can 5. Editing possible
3. No access rights 6. Deleting possible
& Note

ScanRouter DocumentServer Ver.1.XXX restricts user access by passwords
configured for each cabinet.

Individual ScanRouter DocumentServer Ver.2. XXX documents and shortcuts
do not have ACL. However, access to them can be controlled by the same
ACL settings configured for the cabinet or folder where they are stored.

11
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Security and access rights in ScanRouter EX Professional/Enterprise

Each ScanRouter EX Professional/Enterprise in-tray has an access control list
(ACL) to restrict users and the operations they can perform. Configuring access
rights for each in-tray restricts viewers and prevents unwanted document tam-
pering. Only users who have specific access rights can access documents in an
in-tray to view and copy them to a client computer.

& Note

ScanRouter V2 Lite/Professional and ScanRouter Enterprise restrict user ac-
cess using passwords configured for each in-tray.



Introduction

Before using DeskTopBinder, read this chapter to understand the basic opera-
tion of DeskTopBinder.

The explanations in this chapter are limited to the operations available inside My
Cabinet, although DeskTopBinder enables users to share documents in the serv-
er by connecting to ScanRouter DocumentServer.

13
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Let's Start Using DeskTopBinder

Starting and Quitting DeskTopBinder

Starting

A click [Start], and then point to [All Programs] or [Programs].

B Point to [DeskTopBinder], and then click [DeskTopBinder].

Windows Update

Praqrams @ ACCEssaries L4

@ Administrative Tools  *
Documents ¥ & Internet Explorer
L
Outlook Express
Settings 4 Ll

=

Adobe Reader 6.0

Search 4

Irfantiew
Help v

trly

&) Function Palette

1€ '8 @ & &Ly

Rur...
By Import & Convert Taal
b
Shut Dawr,., *

'8 [ Windows 2000 Server

File Edit “iew Document Section Tools Help

=101 x|

J i, N

EENEE

ﬁﬁﬂ\ﬁlﬂ

P

El-g] My Workroom
£ My Cabinet
J Trash

Grayscalelmage -

71 My Wark Folder ‘LJ

- 5ample Folder _‘_J
=

[H- Wg Job Elndlng {RPCS Printer)
Windos Document

@
o) . Sample Folder

2o ]|

11
B
B 14
[Total Folders: o [Total documents: 3 v




Starting and Quitting DeskTopBinder

@ Note

Extended Features Wizard appears when DeskTopBinder is started. Add
functions such as input functions, print functions, and network locations
as needed.

In the first dialog box of Extended Features Wizard, if you select the [Do not
show this screen when launching DeskTopBinder] check box, Extended Features
Wizard will not be shown when you subsequently start DeskTopBinder.

p Reference

For details about Extended Features, see p.41 “Extended Features of Desk-
TopBinder”.

A onthe [File] menu, click [Exit].
4% DeskTopBinder Professional - My Workroom,/My Cabinet/Sample Folder 1ol x|
File Edit Yew Document Section Tools Help
Add Dacument [ -y ’ v
IR X d
Create Mew Folder
M _ Sample Folder |
Specific Search. .. -F”
Eroad Search... ayscalelmage | Grayscalelmage . j
Convert = )
utput =)
Print. .. Ctrl+P L;
Print Document Image List, .
Print Document Propetties Summary by List.., E
Back up.., =
Froperties. . 2'
Eeess—— ¢ Y (3]
T.'E
B 14
[ [Total Folders: 0 [Total documents: 3 7

DeskTopBinder exits.

@ Note

When the [Display list of expired documents on exit] check box in the [My Cabi-
net Properties] or [Removable Cabinet Properties] dialog box is selected, the
documents are searched for and the Expired Document list appears when
you quit DeskTopBinder. In the Expired Document list, you can delete un-
necessary documents.

When the [Delete Job Binding documents 24 hours after they were created] check
box in the [Job Binding (RPCS Printer) Properties] dialog box is selected, a con-
firmation message about deleting the documents appears when you quit

DeskTopBinder.

15
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Let's Start Using DeskTopBinder

Basic Operations

This section explains the following basic document operations frequently per-
formed using DeskTopBinder.

Follow the procedures below to start operating DeskTopBinder.
= Adding Documents

Displaying Documents

Printing Documents

Searching for Documents

Editing Documents

Adding Documents

Although various methods are available to add documents to DeskTopBinder,
adding files from Windows Explorer using a drag-and-drop operation and add-
ing documents using a scanner are described as examples.

When an original is scanned using a scanner, the image data of the scanned orig-
inal can be added to DeskTopBinder as a document.

When afile is added from Windows Explorer, the file can be added to DeskTop-
Binder as a document. The file format remains unchanged from when the file
was created with an application.



Basic Operations

Adding files using a drag-and-drop operation

A Drag a file from Windows Explorer and drop it in a folder in the tree pane
of DeskTopBinder, or drop it in the document list pane.

% DeskTopBinder Professional - My Workroom,/My Cabinet /My r =10l x|

File Edit View Document Section Tools Help
M |@DE} ‘|E @Eﬁ"’?|
W . Sample Folder

El-g)) My Workroom
=1 My Cabinet
of Trash

E’ l;’ Iy Work Falder
-

| Sample Folder
- m_ﬁ Job Elndlng (RPCS Prinker)
Windows Document, Move Here

Cancel

LR RI

E3 My Pictures
File Edit VWew Favorites Tools Help i

“=Back = = - | @isearch [YFoders ¢4 | [ OF 3¢ 22

Address I\E C:\Dacuments and Settings|Administratorify Documenﬂ @G0

My Pictures :I . @

b

ColorImage.jpg Sample.jpg
JPEG Image
@ Q|&E =
Type: JPEG Image Size: 78.2KB 78,2 KB [\ my Computer 7
|_ |Total Folders: O [Total documents: 3 4
B onthe menu, click [Copy Here] or [Move Here].
The document is added.
% DeskTopBinder Professional - My Workroom,/My Cabinet/My Work Folder b ':i‘i' =10] x|
File Edit “iew Document Section Tools Help
n 0o

LRI E TR ]
=- My Worke = ——
m .|E,|l b z 7 My otk Folder |-F,

=) Trash
F" ;" Iy Work Folder Qj
. Sample Folder

== mi o Binding (RPCS Priter) =)
= Windos Document 14
[ 1A &ﬂ;l
e
r [Total Folders: o [Total documents: 3 v
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Let's Start Using DeskTopBinder

Adding documents using a scanner

ﬂlmportant
To add documents using a scanner, a TWAIN driver compliant with the scan-
ner must be installed in a client computer beforehand.

A In the tree pane, select the folder where you want to add the document.

4 DeskTopBinder Professional - My Workroom /My Cabinet /My Work Folder 101 x|

File Edit “iew Document Section Tools Help

&8 My Workroom rW

AEEsinaFaT

o Olollmage

= L) sample
—— @ Ilki Job Binding (RPCS Printer)
Windows Document

| |

[ [Tatal Folders: 0 [Total documents: 1

R

B on the [File] menu, point to [Add Document], and then click [Scan...].

% DeskTopBinder Professional - My Workroom /My Cabinet,/My Work Folder = |EI|
File Edit WYiew Document Section Tools Help

#dd Document Create File.., |' ' v
Impotk File. .. G

Create Mew Folder
| 7 My work Falder

x

I l=l MY XY A ¥

Specific Search, .,

Broad Search... Colorlmate
Convert »

Output 3

Prift . Chrl+F

Print Document Image List,,
Print Document Properties Summaty: by List, .

Backup...
Properties...

Exit

< | =

[Scans animage to add as a document. [Total Folders: 0 [Total documents: 1

S
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Viewer starts and the dialog box for scanner settings appears.

RICOH TWAIN Driver Yer.3 : IS330DC(RNP674146) x|

~Mode Document @
% Documnent: IPIaten glass j Soan
E Fhoo  OCR Fiing || Cfentaion: Standaid Odeg [~ =
Al || size: [LT8 1725 11 in) Porrait ] .
Settings:  |Mode : Standard i’ : Preview
Document : Platen glass Side; I j

Orientation : Standard Odeq. Data
Size: LTIB 142211 in) Portrall = | | [T Deskew 10.7 ME

LI—I L [ Start from Scanner
Detail E

Abaut... | Save... | Selzct... | Cloze | Help |

C Make the necessary scanner settings, and then scan.
The confirmation message about completing the scan appears.

scan x|

Scanning arginals complete.

To insert more scans into thiz document, set oniginalz in
the scanner and press [Continue].

| Continue I Complete

D click [Complete].
E onthe [File] menu of Viewer, click [Exit].

£8 New document - DeskTopBinder Yiewer =]
File Edit View Document Section Help

Insert Section 3 'E|’ Ew ‘ & * g;,|

Replace Current Section b —_—

1o0E - 5 Page 141

— > [olalrealm AmE|9 4 > M

Qutput 3 ;I

Frint... Chrl+P

Wiewer Preferences. ..

L

FEE|f wLA e

Exits | [Section: 1f 1 |IPEG Tmage [too%  [11.69%8.27inch  [600 dpi, 24 bit image %

19



20

Let's Start Using DeskTopBinder

The [Enter Document Properties Summary] dialog box appears.

Enter Document Properties Summary

e tb = e A=l | e S can-2 005070519591 3-00001

Creator; I

whork status: ' |nprogess § Complete

E spires;
Created: [ 7 52008 =] [ 7Ea1apM =
Remarks:

] I Cancel | Bateh Ertmy | Help

X

2

F Enter document properties, and then click [OK].

Viewer quits and the scanned original is added as a document.

@ Note

When documents cannot be added using a scanner, check that the scanner
- compliant TWAIN driver is installed in a client computer, or Scan is con-

figured from Extended Features.

/O Reference

For details about Extended Features, see p.41 “Extended Features of Desk-

TopBinder”.



Basic Operations

Displaying Documents

Three methods are available to display documents: using Easy Viewer, using
Viewer, and using an application.

When a document is displayed using Easy Viewer, leafing through documents
is possible. This allows searching for necessary documents by checking the con-
tents of documents.

When a document is displayed using Viewer, various operations can be per-
formed for specified files (sections) that make up the document.

When a document is displayed using the application used to create it, editing the
contents is possible.

Displaying documents using Easy Viewer

A In the document list pane, select the document you want to display.

B on the [View] menu, click [Easy Viewer], or click , the [Easy Viewer] button.
Easy Viewer starts and the document is displayed.

&Y ColorImage - Easy Yiewer _ Ol x|

[l e v pEE Ao 4]yl
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Displaying documents using Viewer

A In the document list pane, select the document you want to display.

B on the [Document] menu, click [Open in Viewer].

# peskTopBinder Professional - My Workroom /My Cabinet /My Work Folder

File Edit View | Document Section Tooks  Help

=10 x|

t%hlmﬂlalﬂ

=1

E| _'J My Open Content Text Search Data

|

" My Work Folder

Combine:

Separate Sections

Pull Out Current Section

. [s‘._i Job Copy Current Section
Wi

m:w

Create Thumbnail...
Create Content Text Search Dy

[ [Tatal folders: o [Total dacuments: 1 v
Viewer starts and the document contents are displayed.

€8 ColorImage - DeskTopBinder Yiewer =10 x|

File Edit Wiew Document Secktion Help

E R =T _

5 3] A/ A|& & ZIEE |0 4F=1 » >||£|L|D|F

=13

=

i

=

|

BED

a

| E

e My Workroc [Section: 1] 1 IPEG Image 100%  [6.67x5.00inch  [36 dpi, 24 bit image: 7
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Displaying documents using an application

A In the document list pane, select the document you want to display using
an application.

B onthe [Document] menu, click [Open in Application].

# peskTopBinder Professional - My Workroom /My Cabinet /My Work Folder 13 x|

File Edit View | Dorument Section Tools  Help
“ Open in Yiewer | ﬁ I@ | & ’ w
z [M i
E| ‘J r:va Open Cantent Text Search+fata . Sample Folder

Y . |
H Combine: [ —
F .| SEparate Sechons lorlmage
=5 : Pull Out Current Section
;_% . [s‘._i Job Copy Current Section

Wi

Create Thumbnail...
Create Content Text Search Data...

EEEL DOX O Lo

[Tatal folders: o [Total dacuments: 1

&

The application starts and the document is displayed.

4 animal00000004.brp - Paint ] -0 x|
File Edit View Image Colors Help

llllllllllllll
el o (B S (MEIREL (B

|F0r Help, click. Help Topics on the Help Menu. >
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? Limitation

Up to 8 applications can be started on the Desk at the same time.
Up to 8 applications can be started from Viewer at the same time.

When multiple Viewers are running, up to 8 applications can be started
from each Viewer.

Searching for Documents

Documents can be searched through information set in document properties.

Two methods are available to search for documents: Broad Search and Specific
Search.

Broad Search enables searching for documents by words or date, and Specific
Search enables searching for documents using more specific conditions.

Also, there are two types of Specific Search: Content Text Search and Keyword
Search. Content Text Search enables searching for all sections of documents that
have Content Text Search data. Keyword Search enables searching for docu-
ments by setting search conditions.

The procedures for Broad Search and Content Text Search are described as ex-
amples.

After a search is complete, documents are listed in the [Search Results List - Desk-
TopBinder Professional] window. Displaying and printing documents is also avail-
able from the window.
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Searching for documents with Broad Search

A In the tree pane, select the cabinet or folder you want to search through.

B onthe [File] menu, click [Broad Search], or click ]H the [Broad Search] button.
The [Broad Search] dialog box appears.

C Make the necessary search settings in the [Search string(s)] box or in other
items, and then click [Search].

Broad Search |

Location(s] to search: IMy “workroom/ty CabinetsS ample Folder Browse... |
¥ Include subfolders

Search stringls]: IImage

' Document name ¢ Properties summary " Properties & Content Test

Separate multiple search strings uzing commas.
Documents containing stings as specified will be returned.

IDate added 'l 0 Arylime

" between 1 6/28/2008 7| g [§7] 6/28/2005 -]

" past I‘I 3: rnothz
" past |1 3: days

Save Conditions. .. Recall Conditions... | Clear |
Search& I Cancel | Help |

The confirmation message about completing the search appears.

D cClick [List Results].

DeskTopBinder Professional X|

i Search complete.

2 document|z] have been found.

| Lizt Aesults kj Change Conditions. .. (it
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The [Search Results List - DeskTopBinder Professional] window appears and the

documents found are displayed in the list.

1¥, Search Results List - DeskTopBinder Professional 10l x|
File Edit Wew Document Section Tools Help
Yy BhEWeLr?
Grayscalelmage F
= =
E]
i

|L0cat\0n: My WiorkroomMy Cabinet{Z) |TDtaI cabinets: 1

[Total documents: 2

B

E onthe [File] menu, click [Close].

The [Search Results List - DeskTopBinder Professional] window closes.
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Searching for documents with Content Text Search

A In the tree pane, select the cabinet or folder you want to search through.

B onthe [File] menu, click [Specific Search], or click , the [Specific Search] but-
ton on the toolbar.
The [Specific Search - My Workroom] dialog box appears.
X

| Keyword Search Content Text Search |

Location(s] to search: IM_l,l Warkroom/ty Cabinet Browse... |

¥ Include subfolder(s)

Criteria: Lo i fny |

Document hame: | IIncIuding j
Creatar: I Ilncluding j
Size: [ = k- | = kB |within the range =
Section name: | IIncIuding j
Comment in nate: I Ilncluding j
Moke: I Mot specified j

‘Work status: INot specified j Ils j
Femarks: | Ilncluding j
Dateadded | [ 7/ 42005 | - [ 70 42005 x] |withi the range 3|

Save Conditions... | Fecal Conditions... | Clear |
Search I Cancel | Help |

C click [Content Text Search].
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D Make the necessary search settings in the [Location(s) to search] and [Search
string(s)] boxes, and then click [Search].

Specific Search - My Workroom x|

Kewmword Search I Content Text Search

Location(s] to search: IM_';' Warkroom Aty Cabinet Browse. .. |

Search sting(s): IDBSKTODBihdeﬂ

Separate multiple search shings uzing commas.
Document(z] containing stringz] specified will be returned.

Save Conditions... Recal Conditions. .. | Clear |
Search I Cancel | Help |

The confirmation message about completing the search appears.
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E click [List Results].

DeskTopBinder Professional

\i) Search complete.
1 document[z] have been found.

| Ligt Results I Change Conditions. ..

[wit

The [Search Results List - DeskTopBinder Professional] window appears and the

documents found are displayed in the list.

1¥, Search Results List - DeskTopBinder Professional 10l x|
File Edit Wew Document Section Tools Help
2 mE 5
vy 33 55 "’v‘
Grayscalelmage F
ECTNER- A =
==

|Lacation: My WorkroomMy Cabinet{Z) |Tatal cabinets: 1

[Total documents: 2

S

F on the [File] menu, click [Close].

The [Search Results List - DeskTopBinder Professional] window closes.
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Printing Documents

In addition to ordinary printing, printing with Easy Print and other print meth-
ods are available.

Use the Print function of DeskTopBinder to create previews and make detailed
print settings.

When DeskTopBinder is incorporated with SmartDeviceMonitor for Client, the
[Notification] dialog box can be displayed at print job completion or if an error oc-
curs during printing.

The procedures for displaying a preview to make detailed print settings includ-
ing Layout and Duplex and printing after you have checked the print conditions,
and making notification settings in the [Extended Features Settings] dialog box of
SmartDeviceMonitor for Client are described as examples.

Printing

ﬂklmportant
To display previews before printing documents, an RPCS printer driver that
supports the preview display function must be installed on a client computer
beforehand.

@ Note

To display previews, under DeskTopBinder Extended Features, in the [Print
Properties] dialog box, the [Perform advanced print settings on the corresponding
printer.] check box must be selected beforehand.

A In the document list pane, select the document you want to print.

B on the [File] menu, click [Print...], or click [}, the [Print] button on the tool-
bar.

The [Print] dialog box appears.



Basic Operations

C Make the necessary print settings after previewing with the print settings
including Layout and Duplex.

& Note
Click [Create Preview] to display a preview of the document.

Some functions might not be available, depending on the printer driver
you are using. For details about which functions are available with which
printer driver versions, see the Compatible Device List.

Print x|
| DeskTopBinder | Job: 141 Mame: Froperties. . |

2 sidec Aficia CLE000 RPCS | Details.. |
Feady ;I

E

Pritit Settings | HeaderfFooterl EditJobl Basic Settingsl

]

Custom Setting name;

| 7|
V' Duplex/Book v Layout ¥ Draw border
ERE
4| | »
a4 17 1(Front sice) ¥ 2
Driginal size: ILetter B j 7| Collate = Purch [~| Staple
[riertation; I Partrait j
Frintout paper size: ISame a3 onginal size j
Murnber of copies: I‘I _,::'
Color/Black and White: | Color =l
Test Prink | Print I Cancel Help
D click [Print].
Printing starts.
P Reference
For details about Extended Features, see p.41 “Extended Features of Desk-
TopBinder”.
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Receiving Notifications

Follow the procedure below to display the [Notification] dialog box if a print job

finishes or an error occurs during printing.

A click [Start], and then point to [Programs].

B Point to [DeskTopBinder], point to [SmartDeviceMonitor for Client], and then click

[Extended Features Settings].
The [Extended Features Settings] dialog box appears.

*5 Extended Features Settings

W Use Extended Features

21|

— Motifization
[~ Motify of printaut/data-transmission/cancellation,
v Motify when emars oocur while printing.

When [Motification] zettings are available on the printer diver,
thoge zettings will take priority,

[ Maotify of printout/data-transmission when using print server

[ Display [Motification] on top

— Recovery/Parallel Printing

[ Set Recovew/Parallel Printing for each port
[ Conduct Recovery Frinting [Detaled Sethings

[ Conduct Parallel Frinting

ol it 2'3_:| CopiEs

Allows you to zet groups for Becovery/Parallel Printing. Group Setings

— Monitar print job

[™ Dizplay task bar izon while printing

()8 I Cancel | Help

C select the [Use Extended Features] check box.
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D Inthe [Notification] area, select when you want to display the [Notification] di-
alog box, and then click [OK].

In the [Notification] area, you can set the following items:

= Notify of printout/data-transmission/cancellation.
Sends a notification when transmission of data to a printer is complete,
printing finishes, or a print job is canceled.

= Notify when errors occur while printing
Sends notification of print results if an error occurs during printing.

= Notify of printout/data-transmission when using print server
Sends notification of printing results when a print job is sent from the print
server.

= Display [Notification] on top
Displays the [Notification] dialog box over other windows.

i@klmportant
When the [Notification] check box is selected, to receive notification, Smart-
DeviceMonitor for Client must be used for printing from the print server.
Also, the setting for notifying a client computer of the printing result must
be made on the print server.

? Limitation

If the settings for notifying of print completion and errors occur during
printing are made using the printer driver, those settings have the priority
over the settings made here.
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Editing Documents

Documents can be edited by two methods: by starting Viewer, or by starting the
application used to create the document.

Using Viewer, operations such as changing order and rotating are possible for
files (sections) that make up the document. For image files: inserting text, draw-
ing figures, and other image processing functions are possible.

Using the application the document was created in, specific files in the docu-
ment can be edited in detail.

The procedures for inserting text into an image, editing the text, and moving an
enclosed area on an image using Viewer are described as examples.

Inserting text into an image

A Display an image document using Viewer.

B click [Edit Image].

48 Colorimage - DeskTopBinder Yiewer i [u] 3]
File Edt View Document Section Help
J||ﬁ B |8 ESeimia B E|u|4)‘g;z|
3 [ A A& alE dma e e » W[ARR[ famee | @
¥ =3
] =
ko i
3 3
=
[ Colordmage &
L

N

[Location: My Workroom / My Cabinet [ [Section: 1/ 1 [3PEG Image oo |5.67 x5.00inch  [96 dpi, 24 bit image

The Edit Image toolbar and the [Graphics] menu appear.

C onthe Edit Image toolbar, click A, the [Insert Text] button, or on the [Graph-
ics] menu, point to [Draw], and then click [Insert Text].

This changes the pointer to 4-.
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D Drag to draw a box for entering text.
A text box is displayed and a cursor appears inside it.

43 ColorImage - DeskTopBinder Yiewer ) i [m] ]

Fle Edt View Document Section Image Graphics Help

EEE e

] len| Ao afmr SEE W Py v 0 || auedinginage |
3 Sy meltsy S TODOGHABRSEF |0 00w

IEEE el e

[Location: My Workroom [ My Cabinet [ [Section: 1/ 1 |3PEG Image [too% 6.5 %5.00inch  [96 dpi, 24 bit image

A

E Enter text.

43 ColorImage - DeskTopBinder Yiewer ] — 1ol x|

File Edt View Document Section Image Graphics Help

Jgnﬁ B | wEl <@ [Featonia = Elu|0!32|

A @l 1 ’l@{almuz j@‘ I4 1|F'EDEV1 » }Ilﬂul;)‘ Quit Editing Imags ”
3 2ymElEsr S TODOGDABSEF D 0%

EEmEE el e

[Location: My Workroom [ My Cabinet [ [Section: 1/ 1 |IPEG Image [100%  [6.6525.00inch  [96 dpi, 24 bit image

1z

F click & , the [Select Image Objects] button, or another button for figure ob-

jects to quit inserting text.
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G 1o change text properties settings, such as font, size, and text color, click
k , the [Select Image Objects] button, and then click the text.

The text box is selected.

48 ColorImage - DeskTopBinder Yiewer ] (=] 53]
File Edt View Document Section Image Graphics Help

Bl e

= 2] 1 A& o= FIEE| 1 4Pz y | 20 12 82 || ouit Ediing Inage |‘
» | |t m@|l 2k |/ TOOOOGHAESE ST o @[t

i =
o ¢

®

L= el

[Location: My Workroom [ My Cabinet [ [Section: 1/ 1 |3PEG Image [too% 6.5 %5.00inch  [96 dpi, 24 bit image 4

H on the [Graphics] menu, click [Properties...].
lnjx
File Edit View Document Section Image | Graphics Help

J ||ﬁ 5l ‘ WEl <E|Secnonm [ BringForward  Curl+F
Send Backward Ctrl+6

o [[9] 1 emgwFone cubshicer |14 4 [Pz b | E] L 1D [ cuitEdiing Inege ”

SendtoBack  Ctrl+Shift+E
5 %DDO@%E&@&IM@ME\
a A
= ; Masking =]
P —
B

L= el

[Location: My Workroom [ My Cabinet [ [Section: 1/ 1 |3PEG Image [too% 6.5 %5.00inch  [96 dpi, 24 bit image 4
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I inthe [Text Properties] dialog box, change the font, size, color, alignment,
and other text settings.

43 Colorimage - DeskTopBinder Yiewer I =100 x|

Fle Edit Wiew Document Section Image Graphics Help

Jﬁ HE BN e =L ‘ R ) 09‘

- Effect
I~ Stikethrough
™ Underline
Color

EEIack =] | Font Tope

W s B0 |[_mutEdiing vage | =

Fon Sty EN ‘E| 3

[Reauer 5

el = =

(} #iisl Black Italic i

() Comic Sans M5 Bold 2

Courier New Bold ltalic =

8 Georgia =

i ~ | Impact ;
[Ef [ Colomage 1] O LucdaConsole =] i
B

Aligrmert 1Y
[(-‘ Leit £ Center £ Right ‘ L . e

[Lacation: My workroom § My Cabinet | [Section: 1f 1 [3PEG Image [100%  [6.6SxS5.000nch |96 dpi, 24 bit image 4

J click [OK] to quit changing the text properties.
The text properties are changed.

Text Properties el 4|
Faont; Style: Size:
Italic 16 | ok %|
i} Aial « | [Reqular - 'IEI
() sl Black 2l cancel |
f} Comic Sanz M5 Bold
g Couner Mew Bold Italic 14
Georgia 116 |
f} Impact 18 Help |
f} Lucida Console ;I ;I 20
— Effects — Sample
[T Stikethrough
[T Underline
Colar
<] | Fort Type

— Alignment;
i+ Left £ Center ™ Right
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K click [Quit Editing Image].
The dialog box for selecting a saving method appears.

L selecta saving method, and then click [OK].

& Note

Changes made in the [Text Properties] dialog box are applied to all charac-
ters in the text box.
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Moving an enclosed area in an image

A Display an image document using Viewer.

B click [Edit Image].
I-TE

Fle Edt View Document Section Image Graphics Help

J@Hﬁ B[ wE E[Eestont | IEIN|0&3?-‘-|

¥ Bl A 1aal ARG (FEm b AR D |[_seesomge |
sl @G22/ TODOGHABRSEF (I 0@t

EEEE el e

[Location: My Workroom [ My Cabinet [ [Section: 1/ 1 |IPEG Image [100%  [6.6525.00inch  [96 dpi, 24 bit image v

The Edit Image toolbar appears.
C on the Edit Image toolbar, click i}, the [Select Range] button.

~loix

File Edt View Document Section Image Graphics Help

| & |[32 B8]« EF=miT BB 2 W

A |& 1 1& ale: FEE| (=i »ov | £1 1 B | outEding megs | 3

- AR/ TODOCGHARNSEE D o d|u |

¥ g b (]

Al vem rl

Al

2 e
9
did
a8

\antinn:My Workroom | My Cabinet [ [Section: 1/ 1 [IPEG Image [100% [6.655.00inch (96 dpi, 24 bit image: 7

This changes the pointer to .
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D Drag to draw a rectangle to enclose the desired area.
The specified area is enclosed by a dotted rectangle.

43 ColorImage - DeskTopBinder Yiewer i i [m] ]

Fle Edt View Document Section Image Graphics Help

EEE e

W O 4 1| el FDE| M 4« [Faeeis bl 2 B0 [ QuitEditing Image ”

i lym@nsy S TODOGHABSEF (T 0w
E : EC r

IEEE el e

[Location: My Workroom [ My Cabinet [ [Section: 1/ 1 |3PEG Image [too% 6.5 %5.00inch  [96 dpi, 24 bit image

wl

E Place the pointer on the enclosed image.
This changes the pointer to & .

F while pressing the left mouse button, drag the enclosed image to the de-
sired position.

G Click [Quit Editing Image].
The dialog box for selecting a saving method appears.

H select a saving method, and then click [OK].



Extended Features

Extended Features settings are required for various DeskTopBinder functions.

To perform document operations in cooperation with ScanRouter V2 Lite/Pro-
fessional, ScanRouter Enterprise, ScanRouter EX Professional/Enterprise, Scan-
Router DocumentServer, or Document Server (MFP), they must be added as
network locations from DeskTopBinder Extended Features.

After they are configured as network locations, the icons for network locations
appear under the DeskTopBinder tree.

Using Extended Features, you can also configure input/output functions, con-
version functions, and tools to use them with DeskTopBinder.

You can also change properties of functions and delete unnecessary functions.

Before using DeskTopBinder, be sure to add and configure functions from Ex-
tended Features.
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Operations in Extended Features

Settings for Network Locations

The related devices or programs are displayed under the DeskTopBinder tree
and can be used in cooperation with DeskTopBinder.

Using these devices or programs, the following are possible:

Control Windows Document with DeskTopBinder
Control documents in ScanRouter DocumentServer *

Create shared cabinets to make DeskTopBinder documents available for mul-
tiple users *

Create removable cabinets that can be used in other client computers *
In cooperation with ScanRouter, control documents in in-trays
Control documents in Document Server (MFP)

Control documents in Job Binding (RPCS Printer)

Limitation

If you are using DeskTopBinder Lite, you cannot make settings for functions
marked "*".

/O Reference

For more information about possible functions incorporated with network lo-
cations, see DeskTopBinder Help.



Operations in Extended Features

Procedure for adding network locations

Start DeskTopBinder, and then click [Extended Features...] on the [Tools] menu.
The procedure for adding a network device Document Server (MFP) is given
here as an example.

When Document Server (MFP) is added, documents in Document Server (MFP)
can be viewed and managed using DeskTopBinder.

P Reference
For setting procedures for other functions, see DeskTopBinder Help.

A on the [Tools] menu, click [Extended Features...].

# peskTopBinder Professional - My Workroom /My Cabinet /Sample Folder i ' e = | a LI
File Edit View Document 3ection | Tools Help
BE Q. [mi Scanner Setkings... | ) ‘ v
= “ ﬁ B8 TH 1 pr——r—mw— i | & Z
v Workroom Preferences... _ Sample Folder |
My Cabinet F”
) Trash guteipucunen: Lk B g DeskTopBinder =
7 My Work Folder _I:J
i Sample Folder
= i Job Binding (RPCS Printer) ‘5‘&‘
— | &g Windows Document
3
EgRE B o4 m;J
Grapsoalzimage 'r‘ﬁj
oo
[ |Total folders: 0 [Total documents: 3 v

In the [Extended Features...] dialog box that appears, a list of selectable func-
tions appears in the [Selectable function(s)] list.
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B click the Network icon, and then select [Document Server (MFP)] in the [Select-
able function(s)] list.

Extended Features

Add or delete functions for DeskTopBinder. Click an icon on the [Type] list, oK
then select a function to add,

duik

Tvpe: — Metworking Cancel
_ﬁl zq Select location to be made available on the Tree. Help
Input
Selectable funchion(z):

sy Document Server [MFP)
|:-_-: Document Server [MFP) Authentication/E ncryption

- ScanRouter EX
Output ScanRouter DocumentServer W2

ScanRouter V2
ScanRouter DocumentServer W1

& b

Arvailable function(z] to uze:

My Wi arkraaom ) Eroperties... |
Job Binding [RPCS Frinter)
Wihdows Document Tl |
=
Tools
Up
Do |
C click [Add..].

The [Document Server (MFP) Properties] dialog box appears.

D click [Browse...] to select a network device, or click [Specify...] to enter the IP
address of the network device, and then click [OK]. Enter a user name, user
code, and other information as required.

[Document Server (MFP)] is displayed in the [Available function(s) to use] list.

E click [oK].



Operations in Extended Features

Input Functions

In Input of DeskTopBinder Extended Features, Scan and Easy Scanning settings
are available.

These settings enable you to add scanned images as documents.

ﬁlmportant
To make scanner settings, a TWAIN driver compliant with the scanner must
be installed in the client computer.

Output Functions

In Output of DeskTopBinder Extended Features, you can make settings for the
following functions:

= Easy Print*1

= Print*l

= Send by E-mail

= Send by Fax*2

= Deliver

= Save in Job Binding*1
= PDF Direct Print

ﬂlmportant
You can make settings for functions marked "*1" only if the printer driver in-
stalled on the client computer supports those functions.
You can make settings for the function marked "*2" only if the printer driver
installed on the client computer supports that function.

Conversion Functions

In Convert of DeskTopBinder Extended Features, you can make settings for
Convert to Image, Convert to PDF, and Convert to Text (with OCR).
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Tool Functions

Advanced DeskTopBinder operations are possible using the tool functions in
Tools from DeskTopBinder Extended Features.

You can make settings for the following functions:

Export Document Properties Summary in CSV format
Entry Assistant

Import HTML

Export HTML

Print Document Properties Summary by List

Print Document Image List

Settings in Extended Features Wizard

Start Extended Features Wizard for settings.

New functions can be added by selecting [Extended Features...] on the [Tools]
menu or using Extended Features Wizard.

With Extended Features Wizard, select [Easy settings] or [All function settings] as
the method for adding functions.

Easy settings

[Easy settings] enables the settings for functions with a simple operation by
following the instructions on the display.

However, functions that can be configured are the following:

Print functions

Scanner functions

Document Server (MFP)

Connection to document management servers
Connection to delivery servers

Limitation
If you are using DeskTopBinder Lite, you cannot make settings for the doc-
ument management server.

All function settings

[All function settings] enables the addition and setting of all functions.

The operation for [All function settings] is the same as that performed from the
Extended Features menu ([Extended Features...] on the [Tools] menu).



Operations in Extended Features

Starting Extended Features Wizard

A Click [Start], and then point to [All Programs] or [Programs].
B Point to [DeskTopBinder], and then click [Extended Features Wizard].

@ SmarkDeviceMonitor For Client ’|
@ Auto Document Link Guide

m Auto Document: Link |
E Compatible Devi

w4 DeskTopBinder
#£4 Function Palstte |
@ Accessories » 3 Import & Convert Tool
‘e Inkernet Explorer @ Introduction Guide
L I‘_:ﬁl Outlook Express Readme
» |E| lal=]

@ IrFanievs
Search 4 @ Adobe

\1, Adobe Reader 7.0
I (3 Typeaz4s TWAIN Y »
E— (3 153300C -Network: TWAIN Driver Ver.3

¥

I;ﬁstart
The [Extended Features Wizard] dialog box appears.

IEY-1=00

& Note

Right-clicking the Function Palette icon on the task bar is another way to
start Extended Features.

In the first dialog box of Extended Features Wizard, if you did not select
the [Do not show this screen when launching DeskTopBinder] check box, Extend-
ed Features Wizard will thereafter always appear when you start Desk-
TopBinder.
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Procedures for settings in Extended Features Wizard

Follow the procedure below described as an example of making function set-
tings using [Easy settings].

A Start Extended Features Wizard.

B click [Easy settings], and then click [Start].
x|

- = .} k ! This wizard allows vou to make the advanced functions available in
| - DeskTopBinder.
1 = ﬂ._';_

Select [Eazy settingz] or [All funchion settings], and then click [Start].
i

&« Easy setfings

Fallow instructions in each dialog box to set functions.
Selectable functions: printer, scanner, Document Server [MFP),
document management server, delivery server,

 All function settings

You can zet all funchions.
Thesze zeftings are alzo available in [Extended Features...] under the
[Toolz] menu in DeskT opBinder.

Start

[T Do ot show this scresn when launching Desk T opBindsr Exit |

The [Printing Functionl] dialog box appears.

? Limitation

If you are using DeskTopBinder Lite, you cannot make settings for the doc-
ument management server.
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C Make the necessary settings for print functions, and then click [Next>].

Extended Features Wizard x|

<Printing Function1=

Select the check box of desired functions.
To uge Easy Print, click [Add...] and then select printer.

Lj Print: 2 Lj

Froperties... |
Mormal printing function.
,Q Eazy Print:
‘ou cat use print settings =] EasyFiint

previously zaved.

Add... [elete | Broperties. .. |

< Back I Hext » I Cancel |

The [Printing Function2] dialog box appears.

D Make the necessary PDF Direct Print settings, and then click [Next>].

? Limitation

Only printers that support PDF Direct Print can be used.

Extended Features Wizard A x|

<Printing Function2>
To uze PDF Direct Print, click [4dd...] and then select the printer.

=] FDF Direct Fiint =) PDF Direct Print

High speed printing of PDF files
uzing device POF emulation.

Add... [relete Broperties. ..

< Back I Mext > I Cancel

The [Scanner Function] dialog box appears.
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E Make the necessary settings for scanner functions, and then click [Next>].

ﬂlmportant
To make scanner function settings, a TWAIN driver compliant with the
scanner must be installed in a client computer beforehand.

Extended Features Wizard 4 : xl

<Scanner Function>

Select the check box of desired functions.
To uge Easgp Scanning, click [Add...] and then select scanner.

5# Scan: I~ s__g

Mormal scanning function.

Froperties... |

== Eawm Scanning

== Easy Scanning:

*r'ou can uge scan settings
previously saved.

Add... [relete Fropertiez. ..

< Back I MHest > I Cancel

The [Document Server (MFP)] dialog box appears.

F Make the necessary settings for Document Server (MFP), and then click [Next>].
x|

<Document Server (MFP)>

Select the check box(es] of desired device(s).
To connect to Document Server [MFP). click [Add...] and then specify device.

:ﬁ Document Server [MFP): r _.ﬁ Document Server [MFP): Authentication/Encryption Froperties... |

Authentication/Encryption:

‘r'ou can access stored files in -
authentication compliant MFPz. j"_. Diocument Server [MEP):

_'}_, Document Server [MEP):

‘r'ou can access stored files in
MFP, such as Aficia.

Add... Delete Eroperties... |

Cancel |

? Limitation

You may be asked for a password depending on the network device you
are connecting. For more information about the password, consult the ad-
ministrator of the network device.

The [Document Management Server Connection] dialog box appears.
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G Make the necessary settings for document management servers to be con-
nected, and then click [Next>].

Extended Features Wizard ] ! x|

<Document Management Server Connection>

To connect to server, click [Add...] and then select server.

Cannection:

<<Selectable Servers:>

#J ScanRouter DocumentS erver
W1

#) ScarRiouter DocumentS erver
Add.. [elete Eroperties...

< Back I Mext > I Cancel

? Limitation

The [Document Management Server Connection] dialog box does not appear in
DeskTopBinder Lite.

You may be asked for a user name, password, and domain name depend-
ing on the document management server you are connecting. For more in-
formation about the user name, password, and domain name, consult the
administrator of the server.

The [Delivery Server Connection] dialog box appears.

H Make the necessary settings for delivery servers to be connected, and then
click [Next>].

Extended Features Wizard i x|

"“. <Delivery Server Connection>

To connect to server, click [4dd...] and then select server.

Caonnection:

<<Selectable Servers:>

% ScanPouter Y2

% ScarPouter ExX

Delete Froperties. ..

< Back Hext > Cancel
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Limitation

You may be asked for a user name, password, and domain name depend-
ing on the delivery server you are connecting. For more information about
the user name, password, and domain name, consult the administrator of
the server.

The [Completion of Extended Features Settings] dialog box appears.

I Check the Extended Features settings, and then click [Finish].

Limitation

If there is no Document Server (MFP), document management server, and
delivery server on the network, Extended Features settings cannot be
made.



e
4. Structure of DeskTopBinder

Structure of DeskTopBinder

DeskTopBinder consists of DeskTopBinder itself and the following: Function
Palette, Auto Document Link, and SmartDeviceMonitor for Client.

DeskTopBinder

DeskTopBinder can integrate various kinds of data, such as files made with dif-
ferent applications, scanned image data, and existing image files for total docu-
ment management.

If network locations are added from Extended Features, you can view and man-
age documents in ScanRouter V2 Lite/Professional, ScanRouter Enterprise, or
ScanRouter EX Professional/Enterprise in-trays, or ScanRouter DocumentServ-
er cabinets using DeskTopBinder.

Furthermore, when DeskTopBinder is used with input/output devices, adding
scanned-in documents and outputting (Print and Send by Fax) documents from
DeskTopBinder are available. Depending on the network devices, saved docu-
ments in Document Servers can be copied to DeskTopBinder. Documents in
Document Servers can also be printed and outputted from DeskTopBinder.

Function Palette

DeskTopBinder functions are displayed on Function Palette if these functions
are configured using DeskTopBinder Extended Features in advance. Without
starting DeskTopBinder, functions, such as printing and Convert to Image can
be used for Windows files, and scanned originals can be added as documents.
You can also use these functions by moving a file to the button on Function Pal-
ette using a drag-and-drop operation or by right-clicking a file.

P Reference
For details about Function Palette, see p.79 “Using Function Palette”.

Auto Document Link

If delivery server in-trays, specific folders, Fax Received Files, and a Caplio dig-
ital camera are configured as monitored items, Auto Document Link transfer
documents or files in the items and add them to DeskTopBinder or ScanRouter
DocumentServer, or save them in other Windows folders.

/O Reference

For details about Auto Document Link, see p.93 “Using Auto Document
Link” or “Auto Document Link Guide”.
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SmartDeviceMonitor for Client

SmartDeviceMonitor for Client automatically searches for printers on the net-
work and sends print data directly from client computers to the printers without
using a print server. Furthermore, SmartDeviceMonitor for Client can monitor
pri